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Connexion a un routeur réseau

Connectez le lecteur au routeur réseau via une des méthodes illustrées sur

cette page.

I Réseau cablé

Modem large bande
(avec routeur intégreé)

‘Q Service large
(T ) bande

=

L Service large

(oo ) bande

Modem large bande

£

Routeur

% Remarques

I Réseau sans fil

-+

Si le modéle du lecteur utilisé ne dispose
pas de fonction Wi-Fi intégrée, vous
devrez recourir a un adaptateur LAN sans
fil de Samsung.

Routeur sans fil

Service large bande

& Remarques
e Pour plus d'informations, veuillez vous reporter au manuel d'utilisation du lecteur.

e |l est possible que I'acces Internet au serveur de mise a jour Samsung ne soit pas
autorisé, selon le routeur que vous utilisez ou le contrat établi avec votre fournisseur

d'acces. Pour de plus amples informations, contactez votre fournisseur d'acces
Internet.

e |es utilisateurs DSL doivent passer par un routeur pour la connexion au réseau.
e Pour utiliser la fonction AllShare, vous devez connecter I'ordinateur au réseau, tel

gu’indiqué dans les illustrations a gauche. La connexion peut étre cablée ou sans fil.
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Configuration de la connexion réseau :

Etapes initiales

Appuyez sur le bouton [HOME] de

la télécommande.

HOME

Depuis I'écran
Accuell, accédez a
<Parametres>, puis
appuyez sur le bouton

=.

5

Parametres

Régler diverses fonctions selon vos préférences.

m B
AllShare Play 2

D WPS(PBC)

Sélectionnez
<Réseau>, puis
appuyez sur le bouton

=.

) Affichage

Audio

Réseau

Systéme

Assistance

Paramétres réseau

Etat du réseau

Wi-Fi Direct

AP logiciel

Paramétres AllShare

Nom de I'app. [BDJE5900

Paramétres BD-Live
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Allez sur <Parameétres
réseau>, puis
appuyez sur le bouton

Réseau

.~ O

—_—
Etat du réseau -

Wi-Fi Direct Régler la connexion
réseau pour profiter de
AP logiciel diverses fonctions telles
que des services Internet
m‘ ou AllShare, et pour
effectuer des mises a

niveau logicielles.
Nom de I'app. 9

Paramétres BD-Live

Lorsque la fenétre
Parameétres réseau
s'affiche, reportez-
VOUS a la section

« Réseaux cablés », en
page 5 ou « Réseaux
sans fil », en page

6, pour terminer la
configuration du
réseaul.

Parameétres réseau

Vous devez ensuite configurer un réseau sans fil au
moyen d'un adaptateur de réseau local interne.

(Bmarrer)

Annuler

Sivous souhaitez vous connecter a votre réseau cablé,
branchez un cable réseau.




I Réseaux cablés

Céblé - Automatique Céblé - Configuration manuelle
Optez pour la procédure automatique si le réseau ne requiert pas Si vous disposez d'une adresse IP fixe ou si la procédure automatique
d'adresse IP fixe. La plupart des réseaux n'exigent pas d'adresse IP fixe. est inopérante, vous devrez définir les valeurs de Parametres réseau

manuellement.

Sé|eCtionneZ v Paramétres réseau
Démarrer dans le Sélectionnez Démarrer depuis I'écran Parametres réseau, puis

menu Paramétres lc\f)zljyf:zs:ll;z;gi:;flpourconfigurerlesparamétres appuyez Sur |e bOUton ' I—Iécran Etat du réseau apparaTt I—e

réseau, puis appuyez e lecteur tente de vérifier la connexion réseau et échoue.
sur |e bOUtOI’] . @ Annmer ............................................................... RSSO
% Habltue”ement) Sivous souhaitez vous connecter a votre réseau sans SéleCtlonneZ <Param' Parameétres réseau
|'é|ément <Démarrer> fil, débranchez le cable réseau. |P>, é |a dI’OIte de . ' N tt ’ e
est automaglg}luement 'écran, puis appuyez
miIS en surpriflance. sur |e bOUtOﬂ ' fa ,qur./fﬁ Précédent
................................................................. L'écran Paramétres ”:) M
Le |eCteUF Vénfle |a Paramétres réseau apparalt ’ Vous étes connecté a Internet. Si vous avez de la difficulté a

utiliser un service en ligne, veuillez contacter votre fournisseur de
service Internet.

connexion réseau
puis se connecte au

Connexions Internet et au réseau cablé établies.

réseau ) . -J-’-J-ﬁ Précédent
5 sl

Appuyez sur le R -

= Sélectionnez le champ Mode IP, puis réglez-le sur Manuel.
bOUton |Orsque V9|..|s étes conpecté élInternet‘. Sivous avez dela difficuIFé a m
|e pI’OCGSSUS de |a ::—Illsii:l;:(s:r:’el:_e en ligne, veuillez contacter votre fournisseur de
connexion réseau est
termine.
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Utilisez les boutons numériques de la télécommande pour entrer les
valeurs de parametres réseau. Servez-vous des boutons A Y < »
de la télécommande pour passer d'un champ de saisie a I'autre.

2 Vous pouvez obtenir ces valeurs aupres de votre fournisseur Internet. Vous
pouvez aussi afficher ces valeurs sur la plupart des ordinateurs Windows.

Une fois que vous [ Paramétres réseau
avez terminég,

sélectionnez OK, puis
appuyez sur le bouton — R Précédent
). Le lecteur vérifie s

Connexions Internet et au réseau cablé établies.

Réess.

la connexion réseau ~x
Vous &tes connecté a Internet. Si vous avez de la difficulté a
| utiliser un service en ligne, veuillez contacter votre fournisseur de
DUIS Se ConneCte au service Internet.

réseau.
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I Réseaux sans fil

Assurez-vous que le point d'acces auquel vous souhaitez connecter
votre lecteur est activé. Le point d'acces peut étre un routeur sans fil,
un modem, etc.

Sélectionnez I
Démarrer dans le
menu Parametres
réseau, puis appuyez
sur le bouton [E].

Vous devez ensuite configurer un réseau sans fil au
moyen d'un adaptateur de réseau local interne.

Annuler

™ Hab'tue”ement, Sivous souhaitez vous connecter a votre réseau cablé,
|Ié|ément <Démarrer> branchez un cable réseau.
est automatiquement
mis en surbrillance.

Appuyez sur le | paramétres réseau
bouton [&]J. Le lecteur
lance le balayage des
points d'accés. A

la fin de I'opération,

il affiche une liste

des points d'acces
détectés.

~

Recherche routeur sans fil...




Passez au point
d'acces auquel vous
souhaitez connecter le
lecteur, puis appuyez
sur le bouton (E).
L'élément <Suivant>
est automatiquement
mis en surbrillance.

Appuyez sur le

bouton [&). Le lecteur
se connecte au
réseau.

2 Si votre réseau
dispose d'une clé de
sécurité, la fenétre de
saisie correspondante
apparaitra. Entrez la clé
via le clavier. Une fois
'opération termingée,
servez-vous des
boutons A ¥ < » pour
sélectionner Suivant,
appuyez sur le bouton
&), puis passez a
|'étape 6.

Paramétres réseau

Sélect. votre routeur sans fil dans la liste.

-

® iptime23 "7“' = ul

Rafraichir
ATES_02 il WPS(PBC)
ELT (= Précédent

[

Annuler

Mirhenge_edu
elt3

linksys3

Paramétres réseau

Réseau sans fil et connexion Internet configurés et préts a
étre utilisés.

-y -G

iptime23 ul

Précédent
Param.IP

Réess.

-

Vous étes connecté a Internet. Si vous avez de la difficulté a
utiliser un service en ligne, veuillez contacter votre fournisseur de
service Internet.

Si vous souhaitez
utiliser une adresse IP
fixe, sélectionnez
<Param. IP> a
I'écran, puis entrez
manuellement les
parametres de
I'adresse IP requis.

- Adresse IP

- Masque s.-réseau

Réseau sans fil et connexion Internet configurés et préts a
étre utilisés.

-y -G

iptime23 ul

Vous étes connecté a Internet. Si vous avez de la difficulté a
utiliser un service en ligne, veuillez contacter votre fournisseur de
service Internet.

- Passerelle
- Serveur DNS

Paramétres réseau

Précédent

Paramétres réseau

Une fois que vous
avez effectué la
configuration des
parametres réseau,
appuyez sur le bouton
<OK>.

Réseau sans fil et connexion Internet configurés et préts a
étre utilisés.

e Ay ﬂ

iptime23 ul

Vous &tes connecté a Internet. Si vous avez de la difficulté a
utiliser un service en ligne, veuillez contacter votre fournisseur de
service Internet.

v’ Utilisation d'un appareil prenant en charge le protocole WPS

Précédent
Param.IP

Réess.

L

1. Exécutez les étapes 1 a 5 de la section « Configuration de la connexion réseau : Etapes

initiales ».
2. Sélectionnez « WPS(PBC) ».
3. Suivez les instructions qui s'affichent a I'écran.

% Remarques

- Les appareils prenant en charge le protocole WPS disposent d'un bouton WPS

(PBC).

7 - Frangais



Installation et utilisation de I'application
AllShare sur votre ordinateur

I Téléchargement de I'application AllShare 6

Pour utiliser AllShare sur votre ordinateur ou un périphérique DLNA,

Depuis I'onglet Logiciels, cliquez sur I'icone Fichier, a droite de la ligne
AllShare.

vous devez préalablement installer I'application AllShare sur I'ordinateur
concerné. 7
Vous pouvez télécharger le logiciel AllShare et obtenir des instructions

détaillées sur ['utilisation de la fonction AllShare depuis le site Web

Dans la fenétre contextuelle qui apparait, cliquez sur Sauvegarder le
fichier.

Samsung.com.

1 Allez sur www.samsung.com.

Recherchez le fichier d'installation AllShare sur votre disque, puis
cliquez deux fois sur le fichier.

2 Cliquez sur Assistance dans le haut de la page.

3 Sur la page Assistance, saisissez le numéro de modele de votre
lecteur dans le champ Numéro de modele, puis appuyez sur le
bouton Rechercher le produit.

4 Sur la page qui apparait, cliquez sur la commande Télécharger,
située a gauche, sous Téléchargements. La page Centre de
télechargement apparat.

5 Sur la page Centre de téléchargement, cliquez sur I'onglet Logiciels.
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Dans la fenétre contextuelle qui apparait, cliquez sur Exécuter, puis
suivez les directives qui s'affichent a I'écran.



o)|share

I Installation du logiciel AllShare

Pour installer le logiciel AllShare, exécutez les étapes suivantes.

Samsung AllShare - InstallShield Wizard

1 Aprés avoir téléchargé le logiciel AlShare, lancez le programme 4. Les fichiers requis
d'installation. pour |'exécution du
logiciel sont alors e

: | | *DLNA-ready devices (computers, T¥s, mobile phones, camcorders, digital cameras, etc.)
H A ia a local network.
installes. :
A H = " Cecpooa ]
2 Sélectionnez la langue

Install Status

Samsung AllShare - InstallShield Wizard

E -

. . il o mpe® !

de VOtre ChO|X, pUIS @ Select the language for the installation from the choices below. ‘ ﬂ \ : R E m
cliquez sur « OK ». '

English [United Kingdom) Instaling HotFix...

l ak J [ Cancel

Cancel

3 Accédera

.
Samsung AllShare - InstallShield Wizard

1 License agreement and choose destination location
I'emplacement _ - .
P Please oed bo Lense Agoemert. Une fois I'installation Samsung AllShare - InstallShield Wizard
d 1 i nstal |ation du 0 continue installation, you must agres to the License &greement. L,
| Co | | | Destination Folder termlnee et |eS Install5hield Wizard Complete
ogicle our lire le C:AP Files\S AIS harsh, . 7 7 i =
g p . rogram Filesia amsung \are Change... raCCOUrC|S CreeS, n""! i Setup has finished instaling Samsung AlShare an your
contrat de license. P - LU
Lis ageement sélectionnez si vous
S| VOuSs ad hérez Agreement on S amsung &llShare End-User Licence A .
_ _ 3 souhaitez ou non lancer [7]Crste Shoteut an Deskiop
aux Condltlons ﬁ:ad caref:;l!l]yblhfe Agregmiﬂt onfStamsung_.:hIIShtara End-Uster It_!c;ance t[_haralnafter, the
greement IEfOre using the software az It contains important information. |e |O iCiel uis Cli uez D Fun Samsung AlShare
d 1 utlllsa.tlon du |Og|C|e| Samsung AllShare is a software program [hereinafter. the "software™) designed to share g ! p q _— | ol
and play diverse contents such as photos, music and videos through S amsung H. el
! Electronics” digital devices [cell phones, personal computers, MP3 players, digital cameras, Sur « FInISh » pour GIFShﬂre
4 H camcorders, ete.].
sélectionnez « | accept - alaar [ -
p By using this software, you agree ta comply with the Agreement. Otherwise, pou cannot flnallser | InStallatlon .
uze this software. When pou click the Yes button ta install the software, you are deemed
the terms of the @ —_—
H | accept the terms of the license agreement
license agreement »,
puis C”queZ Sur InstallShield
Next
« Next ».

9 - Francais



I Disposition des écrans AllShare

Le logiciel AllShare comporte trois écrans.

Ecran Gestion de fichiers C. Boutons Lecture sur un autre périphérique / Transfert vers un
autre périphérique / Sauvegarde sur le Poste de travail

Pour accéder a I'écran
Gestion de fichiers, —

» My Computer's Shared folder

sélectionnez View > e ol [ [ [
5] NP 0111160 [J— . e . . |2 . . L. L.

File management s cmormonrc s | - e Transfer to another device : Appelle I'écran de sélection du périphérique vers
o

lequel vous souhaitez transférer le contenu choisi.
screen mode dans le menu | &~

Supérieur ou cliquez sur le
bouton File management
screen mode.

e Play on another device : Appelle I'écran de sélection du périphérique sur lequel
vous souhaitez lire le contenu choisi.

Content List

e Save to My Computer : Appelle I'écran de sélection du dossier sur lequel vous
souhaitez enregistrer le contenu choisi.

D. Fonctions supplémentaires

e Refresh : Actualise la liste toute entiere.

A. Zone de navigation e List view/Thumbnail view : Permet, lorsqu'on clique dessus, de changer la
méthode d'affichage de liste.

e Connected shared device : Affiche le contenu partagé sur les périphériques

connectés a votre ordinateur (identifié a I'écran comme étant Poste de travail). e Recherche : Recherche le contenu souhaité dans la zone des listes de contenus.

e Content list : Affiche le contenu par catégorie de vidéo/photo/musique.
e Transfer/Back up list : Affiche I'état de progression ou d'achévement des E. Player control screen mode

opérations de transfert et de sauvegarde. e Bascule en mode Ecran de commande du lecteur.
e Playlist : Crée et exécute une liste d'écoute personnalisée de morceaux, de
photos ou de vidéos.

B. Zone de la liste de contenus

e Affiche le contenu de la liste que vous sélectionnez dans la zone de navigation.
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Connexion au lecteur et a d'autres
périphériques compatibles DLNA

Avant de pouvoir connecter votre ordinateur a un périphérique, vous devez

d'abord le relier a votre réseau domestique.

% Remarques

- Sivous n'arrivez pas a effectuer la connexion a votre réseau domestique, veuillez
contacter votre administrateur réseau ou votre fournisseur de routeur ou de services

Internet.

- Sivous rencontrez des difficultés de connexion a un périphérique DLNA (comme
par exemple, un téléphone mobile), veuillez consulter le manuel d'utilisation du

périphérique concerné.

I Autorisation d'accés accordée a un périphérique

connecté

1 Accédez a l'onglet
Tools > Settings >
Privilege settings.

Settings

Folder seffings Privilege settings Server ‘

Sharing privilege settings for My Computer
Set use privileges for My Computer’s Shared folder for each connected device

[7] Always allow (Don't show pop-up againy

Parametres des privileges du Poste de travail, configurez les
privileges de partage que chaque périphérique connecté a en
commun avec le dossier partagé du Poste de travail.

e Sivous sélectionnez Toujours autoriser, les périphériques pourront
utiliser le contenu partagé sur le Poste de travail a la premiére
requéte d'acces, sans générer de fenétre de notification contextuelle.

e Allow all/Forbid all : Autorise/interdit les privileges d'acces a tous
les périphériques actuellement connectés.

e \/ous pouvez définir les privileges d'acces des différents
périphériques en sélectionnant la commande autoriser/bloquer,
située a coté de chaque périphérique dans la liste.

e Pour retirer un périphérique de la liste, cliquez sur le bouton [x]
situé a coté du périphérique concerné.

Windows-Media-Player
IP address : 162.183.0.48

Mozilla/4.0 (compatible; UPRP/1.0; Windows NT/5.1)
IP address : 102.168.0.4

Windows-Media-Player

@alow  OBock  [x] 1
@alow  OBlock  [3]
@alow OBk [x]| o

Allow remote playback on My Computer
] Always show pop-up when playback is requesied

@ Arways allow
) Never aliow
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Dans Autoriser la lecture distante sur le Poste de travail, définissez
les regles de lecture distante pour les périphériques qui accedent au
Poste de travalil.

e « Always show pop-up when playback is requested » : Lorsque
cette option est sélectionnée, AllShare affiche les requétes de
lecture émises par d'autres périphériques au Poste de travalil
sous forme d'une fenétre contextuelle.

e Always allow : Lorqu'un autre périphérique envoie une demande
de lecture au Poste de travall, la lecture est accordée sans fenétre
de notification contextuelle.

e Never allow : Les périphériques ne peuvent pas étre lus sur le
Poste de travail.



Ajout de dossiers partagés

Vous pouvez ajouter un dossier partage en effectuant I'une des actions
suivantes :
e Dans I'écran Gestion de fichiers, cliquez sur le bouton Dossier partagé [+], en haut de

Liste d'appareils a gauche, sélectionnez le dossier que vous souhaitez partager dans
la liste qui apparait, puis cliquez sur OK.

e Cliquez sur File > Add shared folder from My Computer, sélectionnez le dossier
que vous souhaitez partager dans la liste qui apparait, puis cliquez sur OK.

e Cliquez sur Tools > Settings > Folder Settings > Add Shared Folder. Sélectionnez
un dossier dans la liste qui apparait, puis cliquez sur OK dans la liste, et cliquez
ensuite a nouveau sur I'onglet Parameétres des dossiers.

Ajout de fichier au dossier partagé dans Poste de travail

Vous pouvez ajouter un fichier a un dossier partagé en effectuant I'une des
actions suivantes :

e Depuis I'écran Gestion de fichiers, cliquez sur Add files to play to the list dans
My Computer's Shared Folder, a droite. Dans la fenétre du fichier qui apparait,
sélectionnez les fichiers que vous souhaiter partager, puis cliquez sur Open. Une
nouvelle fenétre s'affiche dans laquelle vous pouvez cliquer sur Copier, Déplacerou
Annuler. Si vous cliquez sur Copier ou Déplacer, les fichiers apparaitront dans I'écran
Gestion de fichiers.

e Accédez a File > Add File to My Computer's Shared Folder. Dans la fenétre
du fichier qui apparait, sélectionnez les fichiers que vous souhaiter partager, puis
cliquez sur Open. Une nouvelle fenétre s'affiche dans laquelle vous pouvez cliquer
sur Copier, Déplacer ou Annuler. Si vous cliquez sur Copier ou Déplacer, les fichiers
apparaitront dans I'écran Gestion de fichiers.

Ajout effectué depuis I'explorateur Windows

Depuis I'explorateur Windows, sélectionnez le dossier/fichier que vous
souhaitez partager et faites-le glisser dans le dossier partagé du Poste de
travail ou dans la zone des listes de contenus de I'écran Gestion de fichiers
afin de I'ajouter au dossier/fichier partagé.

Création d'une liste d'écoute dans AllShare

@ Fle Edt Toos View Hep _ox

e Ajout d'une liste d'écoute :
Cliquez sur Add new
playlist, a coté de Liste
d'écoute, puis entrez le nom
que vous souhaitez attribuer
a la liste d'écoute.

e Play on another device : -
Cliquez avec le bouton droit e
sur la liste d'écoute que P—
vous souhaitez lire, puis
faites passer le curseur de la souris sur Play on another device afin de sélectionner
le périphérique sur lequel vous souhaitez lire la liste d'écoute.

e Attribution d'un nouveau
nom a une liste d'écoute :
Cliguez avec le bouton + Add New Playlist
droit de la souris sur la liste
d'écoute que vous souhaitez renommer, puis cliquez sur Rename afin d'attribuer un
nouveau nom a la liste d'écoute sélectionnée.

Playlist

e Suppression d'une liste d'écoute : Cliquez avec le bouton droit de la souris sur la liste
d'écoute que vous souhaitez supprimer, puis cliquez sur Delete afin de supprimer la
liste d'écoute sélectionnée.

e Ajout de contenu a une liste d'écoute : Pour ajouter du contenu a une liste d'écoute,
sélectionnez la liste comportant le contenu que vous souhaitez ajouter sous Device
List/Content List dans la zone de navigation, puis sélectionnez le contenu de
votre choix dans la zone Liste de contenus et faites glisser le contenu dans la liste
d'écoute.

e Suppression de contenu d'une liste d'écoute : Sélectionnez la liste d'écoute
comportant le contenu que vous souhaitez supprimer, sélectionnez le contenu a
retirer dans la zone Liste de contenus. Vous pouvez ensuite choisir de cliquer avec
le bouton droit sur le contenu puis de cliquer sur Delete ou d'appuyer sur la touche
Suppr pour supprimer le contenu.

(La suppression d'un contenu d'une liste d'écoute ne le supprime pas pour autant ni
de la Liste de périphériques ni de la Liste de contenus.)

12 - Frangais



ajjsndare

Sélection d'un périphérique depuis I'écran  Lecture du lecteur de disque Blu-ray avec
AllShare Play du lecteur d'autres périphériques

I Connexion d'un téléphone intelligent a un ordinateur pour

Connectez les périphériques souhaités au réseau cablé/sans fil. - . .
perphend la lecture d'un fichier via le lecteur de disque Blu-ray

Utilisez le télephone intelligent pour afficher les fichiers stockés sur

Selectionnez AllShare Play sur I'écran ACCUEIL du lecteur de disque I'ordinateur, puis exécutez un fichier sélectionné via le lecteur Blu-ray sur le

Blu-ray, puis sélectionnez les contenus que vous souhaitez lire (vidéos, telewseur.l . ' N
photos ou musique) (Cette option n'est disponible que sur les téléphones Samsung prenant en

,,,,,,,,,,,, charge la fonctionnalité AllShare.)

Ordinateur

Dans le volet droit de
I'écran, sélectionnez 2010021761
le périphérique sur —
lequel le contenu que
vous souhaitez lire est _—
stocke.

Lecteur de disque Blu-ray

THECNP-PC: 20111115a:

Lecture du fichier de
I'ordinateur

Window

Connexion AllShare .
Commande du fichier de

I'ordinateur sur
le lecteur de disque Blu-ray

% Remarques
- Méme en I'absence d'installation de I'application AllShare, les périphériques DLNA
peuvent étre connectés et apparaitre sur I'écran AllShare Play de votre lecteur. (lls Téléphone intelligent
doivent toutefois avoir été préalablement reliés au réseau.)

- Les périphériques non compatibles avec les appareils Samsung ne peuvent pas étre
connectés.

Connectez I'ordinateur, le téléphone intelligent et le lecteur de disque
Blu-ray au réseau cablé/sans fil.

Exécutez le programme AllShare sur I'ordinateur.
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3 Exécutez le programme AllShare sur le téléphone puis connectez
ce dernier a I'ordinateur. (Attention : Vous devez fournir le nom de
I'ordinateur utilisé.)

I Lecture de fichiers vidéo depuis I'ordinateur sur le
lecteur

Depuis I'ordinateur, vérifiez la connexion au téléphone.

Vous préférez regarder un film en famille, sur le téléviseur, a partir du lecteur,
plutdt que de le visionner tout seul sur votre ordinateur ?

Essayez d'utiliser AllShare pour transférer le contenu concerné vers le lecteur.
Vous pouvez €galement ajouter du contenu ou un dossier partagé

Une fois la connexion établie, vous pouvez visionner sur le téléphone
des fichiers partagés stockés sur I'ordinateur.

comportant le contenu que vous souhaitez lire.

Ordinateur

Lecteur de disque Blu-ray

Sélectionnez d'abord le fichier souhaité dans la liste partagée, puis
spéecifiez le périphérique de lecture (le lecteur de disque Blu-ray)
souhaite.

Lecture du fichier de
I'ordinateur

Connexion AllShare

Vérifiez que le lecteur Blu-ray est en cours d'exécution du fichier.

1 Allumez le lecteur.

2 Exécutez le logiciel AllShare installé sur I'ordinateur.
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Si le dossier S
comportant la vidéo
que vous souhaitez
lire n'est pas partage,
cliquez sur le bouton
en regard de |'élément
« My computer’s
shared folder » afin
d'ajouter le dossier

Sortorger Tl - -

=

ANiems  4Uni(s) (25268 )

Cliquez sur le bouton
« Play on another
device ».

@ Fle Edt Toos View Hep

AL tems - dUri) (26268

partage.

2 La liste pourra nécessiter un certain temps pour étre recréée si elle comporte
un grand nombre de fichiers.

Sous Liste de R
contenus, sélectionnez
la vidéo que vous
souhaitez lire.

Sélectionnez le
périphérique sur ou
via lequel ou vous
souhaitez lire le
contenu (le lecteur
Blu-ray).

Alitems  Una(s) (25268 )

Aniems ) (25268 )
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Une fois la vidéo mise
en mémoire tampon,
elle s'exécute via le
lecteur et s'affiche sur
I'écran du téléviseur.
2 Assurez-vous de régler

le téléviseur sur la
source a laquelle vous

avez connecté le lecteur

Blu-ray.

[ Alishare Play /Musique / @) D audio

B> Rackoor s |l
B} TrRAcKo02
B TrRACK 003
B TrAcKo004
B TrRAcko0s
B TrACK 006
B TrRACK007
B TrRACK 008
TRACK 009

00:03/02:38

)
©
B TrRACKO10 G

1l G, o

B [@ Changementde page & Outils ) Retour



ajjsndare

I Lecture de fichiers vidéo depuis le téléphone intelligent

sur le lecteur LlJne f0|s la connexion
établie, un message
Téléphone intelligent contextuel s'affiche
pour vous permettre :
d'autoriser I'accés au Novo dipostvo deecade,

lecteur de disque Blu- e
ray.

Lecteur de disque Blu-ray

Configuragdes do AllShare.

O e

Connexion AllShare Lecture du fichier du

téléphone intelligent

Sélectionnez Perm. dans le message contextuel, puis appuyez sur

Connectez le téléphone intelligent et le lecteur de disque Blu-ray au le bouton [B).

réseau cablé/sans fil.

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, & Remarques
- L'élément <Perm.> est automatiquement mis en surbrillance.

S.eleCt'omeZ AllShare Play dans le menu ACCUEIL du lecteur de - Cette fonction ne sera pas prise en charge si le logiciel AllShare n'est pas installé
disque Blu-ray. sur le téléphone intelligent.

Démarrez I'application AllShare sur le teléphone intelligent. Dans
AllShare, sélectionnez le menu Lecture de fichiers depuis le
smartphone sur un autre lecteur.

Sélectionnez le contenu (vidéo, photo ou musique) de votre choix.
Sélectionnez ensuite le périphérique sur lequel vous souhaitez lire le
clip multimedia.
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QUESTIONS-REPONSES

Je viens d'installer AllShare sur mon ordinateur, mais je n'arrive pas a
détecter I'ordinateur sur I'application AllShare du lecteur.

e Veérifiez que le lecteur et I'ordinateur sont correctement branchés et leurs connexions

sécurisées.

e Assurez-vous que toutes les connexions de cable réseau (routeur vers ordinateur,
routeur vers model, etc.) sont correctement branchées et sécurisées.

e \érifiez que le lecteur est connecté au réseau et que sa configuration réseau est
correctement établie.

e Assurez-vous que des adresses IP appropriées ont été attribuées au lecteur et a
['ordinateur.

e \érifiez que le lecteur et I'ordinateur sont connectés au méme segment de réseau.
Comparez les trois premiers ensembles de chiffres dans les adresses IP des deux
appareils. lls doivent étre identiques.

e \eillez a régler le lecteur sur Autorisé dans I'onglet Parameétres des privileges AllShare

(Tools > Settings > Privilege settings).
e Certaines applications pare-feu qui s'exécutent sur I'ordinateur telles que McAfee

ou Norton AntiVirus peuvent bloquer les opérations liées a AllShare ainsi que I'acces

du lecteur a I'ordinateur. Arrétez I'exécution de tels programmes ou réglez-les de
maniere a ce qu'ils autorisent les applications AllShare a accéder a I'ordinateur.

Je n'arrive pas a trouver I'adresse IP du lecteur de disque Blu-ray dans le
menu des réglages des droits d’acces du logiciel AllShare sur I'ordinateur.

e \érifiez que le lecteur est connecté au réseau et que sa configuration réseau est
correctement établie.

e Assurez-vous que des adresses IP appropriées ont été attribuées au lecteur et a
I'ordinateur.

e Vérifiez que le lecteur et I'ordinateur sont connectés au méme segment de réseau.
Comparez les trois premiers ensembles de chiffres dans les adresses IP des deux
appareils. lls doivent étre identiques.

e \/érifiez que le lecteur et I'ordinateur sont connectés au méme routeur.
e | e lecteur peut ne pas étre reconnu sur un certain nombre de modeles ou de

configurations de routeur. Vérifiez si le routeur utilisé prend en charge la multidiffusion.

Le cas échéant, vérifiez la configuration de multidiffusion du routeur.

Je n'arrive pas a retrouver les contenus multimédia, méme si le fichier est
défini pour étre partagé sur I'ordinateur.
e AllShare ne prend pas en charge tous les formats de fichiers partagés. Les fichiers

dont les formats ne sont pas pris en charge par AllShare ne s'afficheront pas a
I'écran de I'ordinateur, méme s'ils sont partagés sur I'ordinateur.

e \ous ne pouvez visionner que les fichiers de vidéo, de photo et de musique.

Les sous-titres s'affichent correctement en cas de lecture de vidéo depuis
un périphérique USB, mais pas lorsque la lecture s'effectue via AllShare et la
connexion a |'ordinateur.

e \érifiez que le fichier de sous-titres et le fichier vidéo portent le méme nom (par ex.,

Edge_City.mp4 and Edge City.srt) et qu'ils sont tous deux stockés dans le méme
dossier.

e Notez que cette fonction n'est prise en charge que sur les produits Samsung
compatibles avec AllShare. Cette fonction ne sera pas prise en charge si le téléphone
intelligent que vous utilisez n'est pas un produit Samsung.
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